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Microsoft PowerPoint 2007

¢ Screen Layout ¢ Slide Show

®Beginning with Home  ® Animation

Tab * Printing
Assoc. Prof. Pannipa Phaiboonnimit —— ¢ Formatting Objects *Tips on Creating a
spted forEnolsh Secten bzn:t;::::uu‘):;::h * Inserting Objects Presentation
* Design ¢ An Example
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Microsoft PowerPoint MS PowerPoint 2007: screen Layout
¢MS PowerPoint is an application software for o | [k
creating slide show presentation and related items = * - B — ** e haie __*

e

*MS PowerPoint can create/ build

B Presentation Slides

: . Slides and Click to add title
® Audience handout (handout document to audiences) 'l:s;:ufs —

B Speaker’s Note (script for a speaker)

2 Qutline page (a page of outline to be presented)
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.~H Notes area

—mrre
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Screen Layout — Quick Access

Toolbar

¢ Contains often-used commands.

% You can press the downward arrow to customize the
toolbar.

e

(Al ﬂ.{)‘(\;,
!a\

N

Home Insert| Customize Quick Access Toolbar
e * New
_Lj : Calibri Open
BE | =
Paste 7 B I UV save
E-mail

Clipboard ™=

il Drind

e —
Screen Layout — MS Office Button

¢ For other version, it will be File menu instead. h@
® Open, Save, Print, Send
°New Presentation
B You can start a new presentation from
* Template

®* Themes

* Blank Presentation
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Screen Layout — The Ribbon (1)

(Ol 9~ 6 B3+
L e
| Home | Insert  Design  Animations  SlideShow  Review  View

pp204100-thai - Microsoft PowerPoint

| = e |55 Layout
3 = % A A=
Lj L3 'Copy \:‘ B Reset e ‘—A‘,')
o Jf Farmat Painter 5?,551:. % Delete |B,I el *A—v*, A [ 5

Home: Clipboard, Slides, Fonts, Paragraph, Drawing, Editing

Insert: Tables, Illustrations, Links, Text, Media Clips

Design: Page Setup, Themes, Background

Animations: Preview, Animation, Transition to this slide

Slide Show: Start Slide Show, Setup, Monitor

Review: Proofing, Comments, Protect

View: Presentation Views, Show/Hide, Zoom, Color/Grayscale, Window, Macros

¢ Extra tabs can appear when you select an object

204100 MS PowerPoint

Templates
* A PowerPoint template is a pattern or blueprint of a

slide or group of slides

204100 MS PowerPoint
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Templates

Agendas
Budgets
Content slides
Design slides
Expense reports
Forms
Inventories
Labels

Memos

Plans

Purchase orders
Resumes
Statements

Examples

Award certificates
Business cards
Contracts
Diagrams

Fax sheets

Gift certificates
Invitations
Letters
Minutes
Planners
Receipts
Schedules
Stationary

Brochures
Calendars
Databases
Envelopes
Flyers
Greeting cards
Invoices
Lists
Newsletters
Postcards
Reports
Schedules
Time sheets

Themes

Avallahie Termplates arel Themes

- Q Home

Aa A AA
Py - eyl
Pr— g -

Aa_ u :-.-.—-- |

mezmEn B ]

1204100 MS PowerPoint

Themes

204100 MS PowerPoint

®To give your presentations a designer-quality look
— a look that includes one or more slide layouts
with coordinating colors, a matching background,

fonts, and effects, you'll want to apply a theme.

Blank Presentation

| gaank Presentmion

Click to add title

Click to add subtitle

204400 MS PowerPoint
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Open and save

¢ Open
> __MS Office Button - Open —> Select File

b%‘

¢ Save)

> MS Office Button 9 Save as 9 LRaN version
9 Type in File Name = OK

204100 MS PowerPoint 13

Adding New Slide

® Add new slide : Home tap — New slide

®  Or Press Ctrl-M

Different views in PowerPoint

(,l‘."_a,) [~ o N " IR Presentationl - M
~ Home tnsert Design Animations Stide Show Review View
&3 2 ;’ (=1 ‘ = 4] >
|t — o 5 Gridlines
[Normal| Side MNotes Siide Slide Handout Notes § View Zoon
Sorter Page Show  Master Master Master heszage Bar pirection -
[Presentation Views] Show/Hide

¢ Creating or editing
® Normal view
o Slide Sorter view
® Notes Page view

5 Master views

204100 MS PowerPoint

Different views in PowerPoint

{_’:tii) o2

= Home  Wmiet  Design  Animstions  ShdeShow  Raview

SN B (B &S e )y S 9 |
View

e Gridlines
IMr Shide Motes Shide Slide Handout Notes 5 Zoon
Sorter Page Show  Master Master Master Meizage Eaf Direction ~

snowude

¢ Normal

o For editing and creating new slides
¢ Slide Sorter

2 See the ordering of slides

° Note Page

P

|'EI§IEEE‘§’.

2 Add notes to the slides

¢ Slide Show

? Show the presentation 204100 MS PowerPoint
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Slide Master

Menus Home Inset  Design  Transitions  Animations  Slide Show

j\ener ide Master [T ruler =
[T cridlines

@ Motes Page Handout Master
Zoom Fitto | Color/Grayscale) Window Macros
[ Reading View | 5| Notes Master [[] Guides Window = 2

Narmal
Master Views Shaw

Presentation Views

| Zoom Macros
T =

¢ Used for:
B Make Changes to All Slides
® Adding and Changing Layout

Home Tab

¢ Slide Layout

¢ Change Font Typeface and Size
¢ Alignment & Text Direction

¢ Drawing

¢ Editing

204100 MS PowerPoint 19

To Close
Note Master

S nevatn | e wo R e

IS Iy (7 e e
- ‘:.._ ¢ Wi ¥, b
Sees Oetani - Ortat— || 4 MU0 4 Paie e

t‘ Motes

Master

Fetn bavel
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Slide Layout

R ¢ On a slide, Define
T | — A

Vcten i o Containers

AR 9 Positioning

9 Format

“Secion Header

e I |7 ¢ Can add your own on Slide

i Master

© Comparisan Title Only
Biank “Cantent with Pieture with
Caption Caption

20
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Change Font Typeface and Size

{} Adobe Caslon Pro

{} Adsbe Caclon Pro Bold

¢ Adobe Garamond Pro

€ Adobe Garamond Pro Bold
e Agency FB

| ALEERIAN

204100 MS PowerPoint

AL ign Animations 'hﬁgeshnw Revi
EmEn Fl -[a < === E ! oo 11 - A w7 [35]
Theme Fonts. || shape
B Calibri e || [B 7 O e s 5 par|A-

1% Calibri Font
Recently Used Fonts
() Amo Pro Smbd
All Fonts

Alignment
*Home -> alignment
| T
[m} =
Align Left CE T e
u] Center Paragraph Fa |
7 Align Right
B Justify
204100 MS PowerPoint 23

Change Text Color

S

Calibri (Body} =

204100 MS PowerPoint

Indentation & Paragraphs
®Increase or Decrease Indentation to Lines of Text

(=~ =)= s =)l

EEEENE] -

Paragraph [ |
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Text Direction

® Change the direction of text

® Select the text, then go to Home Tab —> Text Direction

‘ABC‘

204100 MS PowerPoint
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Formatting Objects

¢ Change the Appearance of 42 Shape Fill ~
. D;” Shape Outling =
Objects (text box, shapes, etc.) 75 hags it

¢ Can change:
2 Objects’ Color (Shape Fill)
® Objects’ Outline
? Adding Effects to Objects

27

Selecting Objects

* Click on the object you want to select
* Depending of type of objects, additional tabs will

appear

26

Shape Fill

S shape-Fill-= # Fing

Theme Colors
H_ AEENNNN

lllllﬁllll

Standard Colors
L ] fEEEEN
Recent Colors

® Adding/Changing Fill Color of an
Object
* Select the object, then go to

® Home Tab —>» Shape Fill
| | NoFin
More Fill Colors..,
icture

B
Gradient {3

2
=
A
=

Texture 3

28
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Shape Outline

* Adding/Changing Outline of an i s o s
Object m mEmmmEe
" Type of line II“"IIII
@ Color {E::E’. —
2 Weight (width) i_l _

¢ Select the object, then go to = [l
“ Home Tab —> Shape Outline 2 ;“ ;

29

e ——
Quick Style

® Adding Styles (fill + outline + effects) to an Object quickly.
® Select the object, then go to
® Home Tab — Quick Styles

B E 6

I a .B.BBBB
Quick 0
Styles ™!
(& & &) ) (&) (o] =
-0
LI IR REY )
tﬂ!h-nn---nu

® Adding/Changing Effects to an

Object, such as:

8 Shadow

= Glow

® Select the object, then go to

® Home Tab —>» Shape Effects

| a2 Shape Fill ~

= shape Qutline =

-l Shape Effects ~

[ —
Shape Effect

O

:

v

v

30

Arrange

© Changing the Order of Objects

2 Which one appear in front/in the back of others
® You can also group objects
© Select the object(s), then go to

® Home Tab —> Arrange

o Then select the ordering/grouping

Arrange

Order Objects
‘E& Ering to Front
24 sendto Back
|.1 Bring Forward
% Send Backward

Group Objects

Position Objects
IZ  Align
Sl Rotate

Eq} Selection Pane...

32
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The Insert Tab

Insert Tab
00+ Presentation] - Microsoft PowerPomnt

—) Home I_E] Detgn  Ammatiom smw«”a.mm l
|} R j’rﬁi. fJ lﬁ iJ d) 4l~j _Jil

i
nm Pieture L‘Iw Pnota srulm SmartArt Chart Text  Hesder WordAnt Date T -Ob.nﬂ
Alsum - Box~ & Footer & Time Hueu!un

Tatsies Links [T |

®*Table °*Photo Album ® Chart

¢ Picture * Shapes ¢ Hyperlink
*Clip Art ¢ Smart Art ¢ Action
More details @
204100 MS PowerPoint 33

Insert Table (2)

® Design Tab is for changing the look (border, color)

:%Mdu;=

#iove et Deugn  dnmations  UdeShow Revew Wiew Deugn | Lapmt

EEE=E=

A0l - Merninlt BawerPoit Tahle Tl

)

Tatm Row

¥ Bareted Aume

Tazie 5 Tt gt Wans Styie

® Layout Tab is for changing how cells/table are

positioned

PRAMINC-Sa - Mirosoft Poserfom Tabde Tach

Desgn  Anwahars  SdeShow  Aeew Ve fegn Lt

E Al ! et 180 ¢
= o SR == BRI S TSR = ”ﬁ‘l 1l egpt 182
g I\I)"\ T
Eelit=t e L = Ila:_: Lo gt Fathy
M Nigreen Tible i "

35

Insert Table (1)
¢ Insert Tab — Table iu 8 @—[

Picture Clip  Photo Shi
At Album -

2 Select dimensions of cells then press Enter of

Left Click

Insert Table

I
I
I o
I
I
I
I
I o

Insert Table..

¢ Table Tools Tabs will appear
2 Design

® Layout

Draw Table

il & E

Excel Spreadsheet

34

Insert Picture

“Insert Tab —> Picture |~ | | [ S mmm
B Select the image you want g
B Click Insert * LSS

i
I

® Format Tab (Picture Tools)

B Alter color, shapes, position, even which part will be shown

(crop)
o) b9 = 080l - Mrdih Prmareint Pizarr Tathy
S o et Oeiign  Animioss  ShdeShew  Beder W [ Famel
@ Bogpeness » Y commnnams ([ 3 e Shape = | Slinea ta Frare = t ugn+ | Il ] gt 238
YU WS e e | ‘|"-‘:=E=E=-zm-u e *A
Syrecin s g Reet A o AeerEreca e | By Seeanbune ShRatres | o e B
At et Stges s snnge = 36
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Insert Clip Art P o

s |
n rr=rr—

*Insert Tab —> Clip Art s —
At

2 Clip Art panel will appear

B Use keywords to search for clip arts

* Type keywords under Search for:

* Click Go

version @ T
\ U Clip art on Offics Snline
——

(6 Tios for findind clios

¢ Clip Arts are not available in later

37

Insert Shapes
®Insert Tab —> Shapes

HEe

[Shopen|Smarsan Crare |

&

Shapes

B Select the shape you want

B Then click-and-drag to draw it on the

slide

Insert SmartArt

° Premade combination of texts and shapes
®Insert Tab —> SmartArt sﬁ
¢ Select SmartArt
® Make changes as you'd like
B Type in Text

2 Change Color and Layout

39

38

e AIVEA CAALAAAAA

40
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Insert Chart

¢ Graphical Representation of

Uﬂ"ﬂ
3 ﬁihﬂﬁﬂﬁ
Data (graph) L TN T

® Insert Tab —> Chart '.!

B Select Chart Type

B Type in Data on

Spreadsheet
B Adjust Details
* Design, Layout and ] e
Format Tabs will appear ] =

41

Category 1 Category 2 Category 3 Category 4

e —
Text Objects

[AZ] Add text
Text
Box

click text box —> drawing text box — typing letter

4. Add ward art
Wardaa
*  Click word art — select type —> typing letter

$2 Add symbol
Fymbal
Click Symbol — select symbol — insert

° When you select a shape or a text object, Format tab (Drawing Tools) will appear
..' "J' ™ B A8 B LR EENMION B - hiitrosch Pawerftiel Uraseng Toaly
Hame: st Detgn Ammatienr  SloeThow  Rew Wiew Famat
:|\ e | 5t g e P Atera- T g ta Frant + [ hga - s
AL Lo @ @ @ [ hape Duttiee - ‘;\. A - Ereowees | B sa s o =
RSN )i = St i 5 B Teaemense | By soetanpine Zafoomee | I

< Ships Efedts =

Insert Text Objects

Insert Tab
'ﬂa Ha9-0 3 Presentation) - Miroioft PowerPoint

= Home @ Design  Ammations  ShoeShow  Redew  View
T ) B4 8 LY T o A3 430w
l.:u- L C:np ‘m‘s!\nruhum Chant  Hpmeding Lot Test  Hesder Wordint Date "m-oﬂtﬂ

Box- &Footer = & Time
Tabes l Thustration I Linky

§

® Text Box

O Insert Tab —> Text Box

2 Click and Drag to position the text box

B Type in the Text

42

Il sy Mape iy 1L Wit Syt i Ao Sw 43

Adding Header and Footer

® Insert Tab —> Header and Footer

E"-" s hootern ﬂT
Slide | Hotes and Handouts |
Include on slide

pate ————>[Ihate and time!

& Time
v * Lpdate aitomatically
Toxt

J\

Apply ta All
Apply
| o

] slide pumber

—/%D Enoter
Hebier
& Foster [Cloon't show on title shide:

22/01/59
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Links

® Hyperlink '9{*_
B Create Link to web page, picture, e-mail, other slide
o Select object — Insert tab —> Hyperlink

¢ Action

B Add the action to the object selected what will be

happen when click or moving mouse cursor over it.

m]

o Select object — Insert tab —> Action

45

Theme

e | mides Wil B

iIIHQEEIE!II s

- | Buittln

T —
* Theme - I

c EOENEEEE offce
BOONEEEE Gyl

© Design — select theme

. TO apply new COlorS to a theme: NONEOEED Fond
® Gk he Colors drop down arrow I £ &

. BONEREEE Opuiest
B Choose a color set or click Create

ROENRCOE one
EOEETCEE ongin
IDIDEIIII Paper

New Theme Colors

u
TITLE

47

[—
Design Tab

* Page Setup & Slide Orientation

Orientation & ﬂﬂ
B sides : |
Stlde ...,
i
) Portrait [Qrientation ~|

®Landseane

Page H_g_lq_ht_:Ei Mates, handouts & autine E il
Setup 118.05 [ em b (3 Portrait
Number slides from: B ‘
Colhnieliy O Landscaps Landscape
‘ 1 E‘ I.j
¢ Themes
¢ Background

204100 MS PowerPoint 46

[——
Background

Background

Design — Background styles

e -
‘ | Hide Background Graphics - ‘

j

Background 5 |

.g Fomat Background...

48
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Slide Show

From From Custom SetUp  Hide

Start Slide Show SetUp

‘:},’) H9-0 7 Presentations - Microsoft PawerPoint
Home Insert Design Animations Slide Show Review

}E * I @ ._ir = ] w3 Record Narmation

(5 Rehearse Timings [#F) Show Presentation On:

| Beginning Curent Side | Siide Show=  Shde Snow Shide ¥ Use Rehearsed Timings

_iﬁ :.| '$‘
Fram From

204100 MS PowerPoint

| Beginning Current Slide ' Slide Show ~
Start Shide Show |

49

Animations Tab

® Slide Transition
® Slide Animation

® Animation Preview

204100 MS PowerPoint
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Slide Slow (cont.)

¢ Custom Slide Show
B Show chosen slides and ordering
¢ Set Up (default) Slide Show
8 Show Type
B Screen
B Custom Order
¢ Hide (current) Slide
¢ Record Narration
® Rehearse Timing

204100 MS PowerPoint
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Slide Transition

| Animations | Slide Show Review Developer Add-Ins Acrobat

,& Transition Sound: | [Mo Sound] i
w ﬂ Transition Spesd Fast =

WQIJ@@

Transition to This Slide

o Slide transitions are the animation-like effects that
occur in Slide Show view when you move from one

slide to the next during an on-screen presentation.

204100 MS PowerPoint
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Using Slide Transition

® Transition Effect
® Transition Sound
¢ Transition Speed

° Apply to All

204100 MS PowerPoint 53

Custom Animation

¢ Effect Options
B Effects
B Timing

® Ordering

204100 MS PowerPoint 55

Slide Animation

® Animation effects and sounds ® To Apply an Animation Effect

can add excitement to your ° Select the object
presentations and help you @ Click the Animations tab on the
emphasize key points while you Ribbon

deliver the slide show B Click Custom Animation

o

Click Add Effect

B Choose the appropriate effect

54

Animation Preview

®To preview the animation on a slide:

B Click the Preview button on the Animations tab

|@@a) 926 -

el

| Home Insert Design |
[ @‘W Mo Animation ~
|| Preview || |22 custom Animation

Preview Animations
204100 MS PowerPoifis - - 56
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Printing Slides

® Handouts

* Notes pages

® Presentation

Handouts for note taking <~

¢ QOutline view [

. View
e - ey

204100 MS PowerPoint 57

Steps to Create a Presentation

1. Plan your content
B Ask yourself:

* What is the purpose of your presentation?

* What message do you want to deliver?

B Write up the outline with all the necessary topics

204100 MS PowerPoint 59

Printing Slides

+[E3 TITLE SLIDE Oultline View of slides
Printing in Notes Pages mmnnm Calor a

Slides printed in Netes Pages will display the DMake sure that Sides i selected in the At what: bav.
Ditis a good idea to Scale side to fit paper

speakar's notes for making the presentation. N P i s ke
These notes do not show on the sreen during the 3[E) Printing Handouts
resentotion DI0ffice Button > Print
Oiselect Handouts from the Aot whst: section
Oselect number of sides to print
Ciselect Seale 1ot paper
Oiselect Frame sides
<[l Printing Handouts for Notes
CI0ffice Button > Print
Oiselect Handouts
DOSelect 3 sides per page
Oielect Scale to ft paper
OSelect Frame shides
Printing in Notes

@ Pages.
Thess arem vy nates far thin slide DiSiden printed in Noten Pages wil dsplay the speakers notes for making tha
presentation.
Inn wayfor the spesker Jot rotes DiThese notes do not show on the screen during the presentation
whila thissiid 2 0n the screen 5[ Printing in Outline View
CiOuthne View shows the text only on the sides
. Thi " TiGutine View printouts are often used to summarize the presentation
C10utine View printouts can ba givan out an handouts

Tha haslid
show on the screenduring the presentation.

204100 MS PowerPoint 58

Steps to Create a Presentation

2. Add details to all topics

B Add important details to all topics.
. Remove any unnecessary details
[m}

Too much graphic/details can be distracting

B One topic per slide.

204100 MS PowerPoint
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Steps to Create a Presentation

3. Support the headline with graphic evidence
o support your points with graphic evidence.
= This can include photos, images, charts and

diagrams.

204100 MS PowerPoint 61

Steps to Create a Presentation

5. Put details in the handouts
B The handouts should have the necessary details
not included in the slides
= PowerPoint supports printing in different formats

e.g. note pages, handouts

204100 MS PowerPoint 6

Steps to Create a Presentation

4. Fine Tuning
- Fonts
. Transition
= Animation

. Too much can be distracting

204100 MS PowerPoint 62

Making Presentation

*Topic: Facts about Cat

®Length: 1 page

204100 MS PowerPoint 64
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Facts about Cats

Facts e!'

® Scientific Name: felis catus

, - Scientific Name
¢ Cats are carnivorous '

ats are carnivc
*Young cats are called kitten s o

°Rub cat’s belly at your own risk!

65
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s
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